A Handbook of Online Teaching:

Resources for Instructors and Administrators at UHD

NOTE: Click on the Bookmarks icon in the upper left corner to see a detailed list of all major sections in this document.
# Table of Contents

Preface ............................................................................................................................................................. iv

Section A: Ten (10) Markers of a Successful Online Course ........................................................ 1

Section B: Preparing Course Materials ................................................................................................ 2
  Critical Steps in Developing an Online Course .......................................................................................... 2
  Syllabus and Schedule ............................................................................................................................... 2
  Projects and Assignments .......................................................................................................................... 3
  Reading Materials ............................................................................................................................................. 4
  Lectures ................................................................................................................................................................ ......... 4
  Discussion Board ....................................................................................................................................................... 4
  Exams, Quizzes, and Tests ............................................................................................................................ 5
  Grade Book ................................................................................................................................................................ ... 5

Section C: Providing Timely Feedback ................................................................................................. 5

Section D: Setting Communication Expectations ............................................................................. 7
  Office Hours ................................................................................................................................................................ .. 7
  Email ................................................................................................................................................................ ............... 7

Section E: Checking Course Navigation and Choosing Appropriate Design Features ...... 8
  Tips for Clear Course Navigation and Visual Design ................................................................................... 8

Section F: Motivating Students and Promoting Their Engagement with Course Materials .......................................................... 10
  Building Relationships with Students and among Students ........................................................................ 10
  Students’ Weekly Participation and Engagement with Course Materials ................................................. 10

Section G: Using Supplemental Programs for Teaching Online .............................................. 10
  Addressing Plagiarism .......................................................................................................................................... 10
  Recording Lectures ................................................................................................................................................ 11

Section H: Accommodating Students with Disabilities................................................................. 13
  “Unreadable” PDFs and Heading Styles .......................................................................................................... 13
  Absence of Alt Tags with Visuals ................................................................................................................... 13
  Closed Captioning ................................................................................................................................................... 14

Section I: UHD CTLE and TTLC Tools and Resources ................................................................. 14

Section J: Course Demonstrations ........................................................................................................ 15

Appendix: Works Cited and Supplemental Bibliography ........................................................................... 16
  Online Education ..................................................................................................................................................... 16
Collaboration............................................................................................................................................................ 16
Assessment................................................................................................................................................................ 17
Organizing Discussions ........................................................................................................................................ 17
Providing Feedback............................................................................................................................................... 17
Student-Instructor Interaction ......................................................................................................................... 17
Addressing Student Needs ................................................................................................................................. 18
Service Learning Activities ................................................................................................................................... 18
Evaluating Online Courses .................................................................................................................................. 18
Preparing Teaching Materials............................................................................................................................. 18
Preface
Dear Colleagues:

The purpose of this handbook is to assist those of you who plan to teach online courses at UHD. The suggestions included in this guide have come from current research on online education, individual experiences of the members of the CHSS Curriculum Committee formed in the fall of 2013, and our knowledgeable colleagues from the TTLC and the Disability Services on campus.

The handbook covers a variety of topics, from how to arrange course materials and Blackboard tools to where to find help if you have a technology issue or accessibility questions. We have also included a bibliography of research articles on online teaching sorted by disciplines, links to sample course designs, teaching and presentation tools, and excellent web resources that can enrich your online teaching.

This guide is not prescriptive. While working on the handbook, the members of the committee strived to provide useful suggestions to make the transition to a virtual classroom as seamless as possible. We hope that you will find our online teaching tips useful and look forward to your suggestions. This handbook will be updated regularly to incorporate new ideas and ensure that we provide our students with high quality learning experiences at UHD.

Sincerely,

CHSS Curriculum Committee Members
David Ryden, History, Chair
Anita Chadha, Political Science
Raquel Chiquillo, Spanish
Sucheta Choudhuri, English
Stacie DeFreitas, Psychology
Natalya Matveeva, Professional Writing
Azar Rejaie, Arts and Humanities
Cindy Stewart, Psychology
Tammis Thomas, English
Section A: Ten (10) Markers of a Successful Online Course

1. The course has a set of clear course objectives, appropriate materials, and assessment techniques. The course materials and assignments are engaging, stimulating, and rigorous.

2. The curriculum design is driven by pedagogical goals, not technology (Cargile Cook 65).

3. The course materials are accessible and easy to navigate. The instructor defines options for students with disabilities.

4. The course syllabus clearly describes technology requirements, time commitments, and required computer skills.

5. The schedule lists all due dates, tasks, and tools needed to complete tasks.

6. The instructor provides students with timely feedback.

7. The instructor gives students opportunities to collaborate with other students.

8. The instructor ensures that students have frequent synchronous and/or asynchronous communications with the instructor and other students.

9. The instructor specifies clear file-naming procedures and submission guidelines (what, where, and how to submit).

10. The instructor establishes his/her presence in the course by posting frequent announcements, sending emails, and responding to questions using the discussion board.
Section B: Preparing Course Materials

Critical Steps in Developing an Online Course

When preparing a new online course, consider the suggestions and steps offered by Kelli Cargile Cook (60-64) and other researchers:

1. Start with defining learning objectives. Objectives should describe what students will be able to do by the end of the semester.
2. Determine how those objectives can be met. Select appropriate types of activities and teaching materials. Materials may include the “presentational” type, such as reading materials, prerecorded lectures, videos, and external websites, and the “interactive” type, such as discussion posts and peer reviews (Cargile Cook 61).
3. Identify and choose appropriate assessment strategies to evaluate students’ progress for each learning outcome. The types of assessments may include quizzes/tests, research projects/assignments, discussion posts, and/or presentations.
4. Decide what technological tools are needed to administer the course, e.g., presentation software for creating lectures with recorded narration and Blackboard features, such as tests and assessments, written assignments, grading rubrics, discussion threads, email, and chat tools.
5. Define what computer/web surfing skills students will need to successfully complete the course.
6. Calculate the approximate weekly time commitment to complete all readings, tests, and assignments and adjust the workload accordingly. The workload in online courses must be the same as regular face-to-face classes.
7. Consider instituting a policy that sets expectations about the number of times per week students are required to access course materials and submit assignments.
8. Explore potential accessibility issues related to course content.

Syllabus and Schedule

Teaching online “requires greater attention to detail, more structure, and additional student monitoring” (Coppola 97). Many online instructors organize their course content and schedule by “instructional units” or by learning modules with specified themes, reading materials, lectures, tasks, and deliverables (Grady and Davis 110-111). Each unit or module must be logical and respond to a specific learning objective or objectives.

In addition to other customary sections, consider adding the following items to the syllabus:

- **Technology requirements**, including access to the Internet; Blackboard; required software to complete assignments, such as Word and Acrobat Reader; storage devices; headphones; a webcam; or any other requirements. Consider adding a statement about mobile devices. Be sure to include a warning that some course materials may not be accessible or correctly displayed by smartphones.
- **Basic computer literacy skills** that students must possess to complete assignments in the course.
- **An attendance policy** that specifies how many times and on which days of the week students are required to access the Blackboard classroom. In addition, discuss the
expected weekly time commitment so that students can plan accordingly. Also, add the university-wide attendance policy.

- The *Statement of Reasonable Accommodations* that should contain information provided by the Office of Disability Services with their most recent contact information.
- *An overview of all folders* that contain course materials and features in Blackboard. Another option is to create a PowerPoint presentation called StartHere.ppt and place it in Blackboard before the syllabus and the schedule. Such an introductory presentation can include a basic overview of the course, instructor credentials, an overview of major folders and functions in Blackboard, file naming procedures, and IT/Blackboard support contact information.
- *Grading policies* that clearly outline grading criteria, assignment weights, and grading rubrics or tools. Specify the time required to finish grading student work so students will know when to expect feedback. Also, explain where and how students can obtain feedback and grades in Blackboard.
- *A clear and detailed schedule* that lists due dates and specific times by which students are required to complete readings and tasks. Also, state where and how (in Assessments, Assignments, Discussions, or via email) students should submit assignments and tests.

**Projects and Assignments**

*Assignment Descriptions*

When designing projects and assignments, keep in mind course objectives. Ideally, each assignment will respond to at least one of the learning objectives. In many cases, students will upload their work, which will then need to be downloaded from Blackboard for review. Consider the following recommendations:

In the assignment description, include clear submission guidelines: describe what to submit, where to submit, in what order, what application to use to complete the assignment, and how to name files. A consistent file naming procedure will help organize students’ files and make it possible to find assignments quickly.

Here is a sample file naming procedure:

```
CourseNumber_LastNameInitialofFirstName_Unit#_ddMonyy
Ex.: Cj3302_SmithM_U1_12Jan20
```

To submit feedback in Blackboard, rename the student’s file by adding instructor initials and the final grade to the file name:

```
Ex.: Cj3302_SmithM_U1_12Jan20_lk_86
```

This procedure will make it possible to know which grade to input in Blackboard without having to open the document.
1. Consider asking students to submit individual assignments as one file. In other words, discourage them from submitting the text, figures, and bibliography in separate files. This will ease the work of downloading files.

2. In order to create a sense of community in an online class, consider introducing collaborative tasks for students to engage with other students in a meaningful way, such as peer reviews. Make sure that the peer review process engages specific assignment criteria and other course materials. For example, a peer review form based on the grading criteria will force students to read and internalize the assignment criteria and revise their own work in the process. By reviewing the work of others, students will reinforce their understanding of course materials and terminology.

**Reading Materials**
For supplemental reading materials, such as external websites or pdfs, place the files or links in a separate folder and sort them by units or learning modules so that students can find them easily. The file size should be no more than 15MB per download. Otherwise, it will take students too much time to download files. Consider using the scanning services available through the library. They ensure the highest quality of all scanned materials.

**Lectures**
Recording lectures is a tedious but useful task. Although it is easy to refer students to handouts with essential information, such handouts may not be an adequate substitute for a lively and engaging presentation that includes remarks and commentary. Prerecorded presentations will help engage students with course materials through the summation of essential points, cases and examples, colorful pictures and/or video clips, and explanations offered through charts and other types of information graphics. Lectures and short talks available through professional organizations, other institutions of higher education, and the library can also be linked to the course.

In order to create a prerecorded presentation, first prepare a script of the lecture with accompanying visual aids. Then choose a program to record the talk. The presentation does not have to be longer than ten minutes. Be mindful of the file size and break down longer presentations for an easy download.

Lectures can be recorded using many different tools. A simple PowerPoint presentation with narration can be a great starting point. You can convert it to an MP4 file (See instructions on p. 11.) and then upload it to **Mediasite**, a system that will store your recordings.

Additional presentation applications are listed in **Section G: Using Supplemental Programs for Teaching Online**.

**Discussion Board**
To promote collaboration, create discussion threads for students to post questions about major assignments and projects in the course. Having separate discussion threads for each
major assignment will make it possible to sort through a large number of questions. For peer reviews, create separate threads for different assignments so that students know where to post drafts and reviews.

Weekly discussion posts can be an effective way to promote learning and establish communication with and among students. At the same time, reading, responding to, and grading posts can take a lot of time and effort (Eaton 39). Thus, before assigning discussion posts, decide which learning outcome the posts will address, what role they will play in the final grade calculation, how they will be graded, and how much instructor feedback will be provided. To maximize learning, consider explaining specific content requirements in the discussion prompt, including the types of evidence students must present, any specific course materials that students need to use, the number of posts they have to respond to, and a word count.

**Exams, Quizzes, and Tests**

Online teaching places certain constraints on the assessment of students' learning. One way to monitor students while they take an exam online is to use Respondus Monitor. This feature allows the use of a webcam to record students while they are taking an exam. See Section I: Blackboard Tools and Resources for more details. In addition, there are ways to assess student learning through a mixture of well-crafted multiple-choice and open-ended questions. Blackboard can randomize questions to reduce instances of plagiarism. Other options include defining the time span during which quizzes are accessible, limiting the amount of time students can spend working on a quiz, and defining the number of attempts.

**Grade Book**

Recording grades in an online course using traditional methods can be time-consuming. The Blackboard Grade Center makes it possible to record scores or letter grades and calculate final grades using different assignment weights. For simplicity, consider using traditional percentages from 0 to 100% that have clear letter grade equivalents and are understood by most students. Students will be able to access their grades through My Grades and view an average of all inputted grades during the semester.

**Section C: Providing Timely Feedback**

Timely feedback is associated with improved learning outcomes (Sadler, 1998), strategy use, as well as self-regulated learning (Nicol & MacFarlane-Dick, 2006). In the digital age, immediate feedback is sometimes expected. Instructors must make it clear when they will provide feedback to students after submission of their work and what type of feedback they should expect (grading rubrics, comments, or level of edits). This information can be provided within the assignment description and grading criteria, the course syllabus, or both.

Make sure to post an announcement in Blackboard reminding students to view feedback in conjunction with their grades. Also, offer further directions for resubmission if revisions are allowed.
Clear assessment, including formative and summative feedback, are essential to student learning in online courses. Shute defines formative feedback as the type of feedback that “represents information communicated to the learner that is intended to modify the learner’s thinking or behavior for the purpose of improving learning” (1). If an instructor asks students to write and revise drafts of projects, he/she uses formative feedback. When offering formative feedback, concentrate on evaluating students’ level of performance (how well a student has responded to the task) and provide simple and clear directions for improvement. Summative feedback refers to the final assessment of student learning that can be done by administering quizzes and tests that cannot be revised.

Formative feedback, and the types of assignments that require revision, is associated with improved student learning outcomes (LeClercq, 2001) and self-regulated learning (Yorke, 2003), in comparison to summative feedback, and should ideally be included in online classes. Below are sample types of assignments and procedures that support formative assessment and feedback.

<table>
<thead>
<tr>
<th>Recommendations</th>
<th>Types of Assignment and Procedures</th>
<th>References</th>
</tr>
</thead>
</table>
| Methods of clarifying performance standards to students | • Provide grading criteria with assignment descriptions.  
• Encourage peer review using grading criteria.  
• Encourage self-assessment using grading criteria.  
• Make reference to a grading rubric or grading criteria.  
• Create a discussion board where students can post questions about grading standards. | Nicol & Milligan, 2006; Palloff & Pratt, 2005 |
| Methods to facilitate self-reflection                | • Ask students to produce summaries of learning activities.  
• Ask students to reflect on assessment.  
• Organize group discussions about assessment.  
• Ask students to produce a chart of learning assessment and related learning outcomes.  
• Assign portfolios. | Cotterill et al., 2005; LeClercq, 2001; Nicol & Milligan, 2006; Palloff & Pratt, 2005 |
| Methods to facilitate self-assessment                | • Create and use self-mastery quizzes with informative feedback for each answer.  
• Use self-scoring quizzes.  
• Create interactive games or laboratory assignments with feedback provided. | Bulls & McKenna, 2004; Nicol & Milligan, 2006 |
| Methods to provide high quality                      | • Offer model answers to tests.  
• Share sample written assignments. | Nicol & Milligan, 2006; Orsmond, |
information about learning
- Provide answer keys.
  Merry, & Reiling, 2002

Methods to encourage dialogue among students and between a professor and students
- Ask for draft submissions on written assignments.
- Publish a model for revised written assignments.
- Use peer review.
- Use student tutors and/or student instructors.
  Davies, 2003; Nicol & Milligan, 2006

Methods to increase student motivation and self-efficacy
- Provide positive comments.
- Recognize effort.
- Encourage improvement and offer opportunities to succeed.
  LeClercq, 2001; Nicol & Milligan, 2006

Methods to close the gap between actual and expected performance
- Provide specific clear guidelines for improvement.
- Use draft submissions.
- Give opportunities to edit discussion posts.
- Offer opportunities for re-testing.
  Davies, 2003; Nicol & Milligan, 2006

### Section D: Setting Communication Expectations

Because online courses limit face-to-face interactions between faculty and students, faculty should make an extra effort to increase faculty-student interaction. Throughout the semester, communicate with students through announcements, feedback, and conferences.

If some form of face-to-face interaction is required (i.e. scheduled conferences or meetings via Zoom, Skype, or phone/chat), make sure that this requirement is carefully outlined in the syllabus.

#### Office Hours

Highly publicize office hours in the syllabus and Blackboard. Due to the busy schedules of many students taking online courses, it is important to offer meetings by appointment as well. Offer one hour per week for each course. If there are certain times of regular availability for meetings beyond office hours, specify such times in the syllabus as well.

Offer a variety of ways to communicate with students and make sure that these possibilities are listed in the syllabus as well as on the course website. Let students know that it is possible to meet in person, on the telephone, or via chat and video conferencing.

To ensure student access, provide tutorials—which are accessible through Blackboard—on the course website. To encourage students to use these tools, include an early low-stake assignment that requires the use of key communication technologies.

#### Email

Include in the syllabus a clearly stated policy for responding to student email messages. Responding within 24-48 hours is often standard. Also, specify an email response policy for holidays, weekends, and other dates of limited or total unavailability, if applicable.
Section E: Checking Course Navigation and Choosing Appropriate Design Features

Thoughtful and consistent organization of elements is a critical component of an online class and online teaching. Effective and consistent choices in the visual structure and organization of the course will help make it easier for students to navigate and understand course content.

Tips for Clear Course Navigation and Visual Design

Content. Determine the elements and basic content to include in the course before beginning the design phase. This will save time in the long run, especially for anyone new to online teaching. Outlines or concept maps are useful tools to help plan the flow of course content.

Course Shell. Become familiar with the capabilities of the university’s course management system. An outline or concept map will help in developing the navigation scheme to adopt in the course. Many decisions will likely be based on face-to-face teaching experience. This experience is valuable, but specialized tools available in the online environment will also provide students with beneficial learning experiences. Using the course management system to its full potential may require training, but that’s what UHD’s TTLC is for.

Simple and Consistent Navigation. A section in the syllabus that lists course folders and explains how to navigate the course can help students find content quickly and easily. This information can be used as an orientation to the course that explains to students how the class site is to be navigated and what content is located where.

Learning modules and periodic units (i.e. weekly or topic units) comprise two effective modes of organizing course content. Avoid requiring students to drill down multiple times to reach course materials; the fewer clicks to reach content, the better. Choosing an organizational format for course content and linking it in a first-page menu will help make it easily and visibly available.

Naming Files, Folders and Functions. Consistency is again key. In naming files, folders, and functions within the class site, be consistent. Make file names simple and descriptive of content. Note that in the latest version of Blackboard, the left-hand menu makes it possible to rename major functions. Here are sample names for different types of materials in a course:

Files
- CJ3302_U1_Lecture_IntroductionToCJ.ppt
- CJ3302_U1_AssignmentDescription.docx

Folders
- Learning Module 1
- Assignment Descriptions
- Presentations and Supplemental Reading Materials

Functions
- Submit Assignments
- Submit Quizzes
- Post in Discussions
See sample video demonstrations of Blackboard shells created by others in Section K: Course Demonstrations and on the CHSS Online Teaching Initiative’s page (The password to access the videos is “CHSS.”).

Content and Accessibility. When uploading materials to the Blackboard shell, consider accessibility issues that may arise from conflicting programs or versions of commonly used word processing programs. If not sure, convert files to PDFs. Using PDFs can help in three ways:

- Instructors can decrease the size of files to be uploaded in the case of large PowerPoint files.
- PDF software is universal, and PDF reader programs are free and readily available.

PDFs will appear streamed (and thus won’t require downloading to a student’s computer for initial viewing) and can be easily saved to a student’s computer for later viewing. Make sure students have the most recent free version of Adobe Reader. Consider reducing the size of all files to no more than 15MB, so students can easily download and store course materials.

Fonts, Colors, Images, and Background Images. Choose clear, legible fonts, such as Arial, Helvetica, Times New Roman, or Calibri, for the text in the documents uploaded to the course site and for course instruction areas and content folders. Arial and Helvetica fonts are easier for most people to read online, especially those with vision problems. Make sure that font sizes are large enough to read comfortably.

Black text on a white or light background is the most legible as it supplies the highest contrast of text to background. Patterns and images placed behind text should be avoided in most cases as it makes content more difficult to read; color and/or pattern may be useful in banners or headlines but is distracting when overused. When used, color should be deployed strategically. The effective use of a color-coded system for different kinds of content requires giving students the key to the code and using the system consistently.

Some courses will require the use of images, sometimes extensively. When using images online, such as in instructions, assessments or images banks, save them at a reasonable size and resolution (as .jpg) so that they will remain entirely visible on a computer screen without the necessity of using arrows to navigate the image. If pulling images from the Internet, select the largest, clearest image available and then decrease the size and/or resolution as necessary. It is a waste of time to try to increase the size or resolution of a small image pulled from the Internet. Instructors may consider keeping an archival-sized image on their computer and also making a smaller one for use in their class site.

Navigation. Select Student View in Blackboard to view the class site from students’ perspective.
Section F: Motivating Students and Promoting Their Engagement with Course Materials

Building Relationships with Students and among Students
It is difficult to build trusting and long-lasting relationships with students in the absence of scheduled face-to-face interactions. At the same time, there are ways to connect to students and motivate them to achieve their education goals in an online environment. Connections can be built through mutual introductions, frequent email communication, and interactions over the phone.

Instructors can introduce themselves at the beginning of the semester using a video recording or a presentation that discusses research, teaching experience, and interests. Instructors can request similar self-introductions from students and ask them to upload their pictures and respond to other students’ posts. Sending out announcements about holidays and breaks as well as events on campus can help students feel connected to the larger UHD community and available resources.

Students’ Weekly Participation and Engagement with Course Materials
To pace students’ efforts in the course, set clear deadlines for completing tasks and assignments. The course schedule may look similar to a face-to-face class, minus the actual classes. Still, students will have to submit quizzes and assignments by clearly specified deadlines.

For longer writing assignments, consider requiring preliminary drafts (1st draft: 50% done; 2nd draft: 80-90% done) before the final draft. Drafts force students to start working early and resolve problems quickly. The preliminary drafts can be assessed on a pass/fail basis as long as they satisfy the length and basic content requirements.

Section G: Using Supplemental Programs for Teaching Online

Addressing Plagiarism
Include a statement on plagiarism in the syllabus. Remind students throughout the semester to document their sources. To curb plagiarism, reemphasize the following:

• Whether in discussion posts, essays, exams, or any other course projects, students should use the citation style appropriate to their discipline: usually, it is the MLA Style or APA Style. Students must cite the sources that they are using whenever they quote or paraphrase from a specific text.

• Remind students that they need to cite all sources they use in their work, whether print, video, audio, or other digital media.

Several programs help ensure that students’ work is original.

*Turnitin*. One way of ensuring that students do not plagiarize assignments is to require the use of *Turnitin*. Create a *Turnitin* assignment in Blackboard and ask students to upload their work. The system will check for plagiarism and generate a report.

Another way to check assignments for plagiarism is by Googling suspicious paragraphs, sentences, or phrases.
Respondus Monitor. This program makes it possible to record students via a webcam. This feature can be useful for administering closed-book tests and exams.

The links to tutorials for these programs are available on the TTLC’s Faculty & Staff Learning Materials page.

Recording Lectures
There are several options when it comes to choosing the program for recording lectures. The choice of the program will depend on the type of information delivered in the lecture and the tools required to make all the points in the lecture. Depending on the size and number of presentation files, consider posting them to a private YouTube site and posting the link to the online class.

Programs for Creating Video Lectures
Microsoft PowerPoint. A PowerPoint lecture can be a good starting point for first-time online instructors. It is easy to add narration using a set of headphones and a microphone. You can then convert the presentation to an MP4 file and upload it to Mediasite, Vimeo, YouTube, or similar video sharing sites for easy viewing. To convert the presentation to an MP4 file in Microsoft PowerPoint 2016, click File → Export → Create a Video. Choose Internet Quality or Low Quality depending on the size and length of the lecture and then click Create Video.

Zoom. Zoom allows to record face-to-face class sessions with students, as well as lectures and short video messages. The recordings can be hosted in the Zoom cloud and accessed via a link or could be downloaded to a computer and then posted on a video sharing site. With Zoom, one can share screens of what is opened on a computer: slides, procedures, examples, and other teaching materials. For more information on Zoom, visit the TTLC’s Faculty & Staff Learning Materials.

- To organize synchronous Zoom sessions in your classes, consult the following resources: Tips & Tricks: Teachers Educating on Zoom Comprehensive Guide to Educating Through Zoom
- Zoom’s breakout rooms function lets you assign your students into groups for discussions if you teach synchronously.
- To get transcripts of your recorded sessions, contact TTLC for a tutorial.
- Instructors can use a variety of background images as virtual backgrounds for conducting Zoom sessions. Review instructions on how to activate the feature and add the background. CTLE has created a database of such possible images.

Screencast-o-matic. This free program will capture everything shown and done on a computer screen. For example, the program can convert a PowerPoint lecture to a video with voice content. The program requires a set of headphones and a microphone.
Doceri. This program is for those who use iPads in teaching. It is similar to Screencast-o-matic but requires a subscription. The program makes it possible to project presentations from an iPad and record PowerPoint presentations with narration.

Prezi. This application can help to effectively visualize information by creating zoomable content and allowing a more intuitive flow of information. It is possible to convert a PowerPoint presentation to Prezi and to add audio files to a Prezi presentation, as well as to convert a Prezi to a PDF.

Snagit. This free application captures a computer screen and allows the creation of effective presentations and instructions.

Video Sharing Sites
The sites below allow posting and sharing links to video and audio materials:

Mediasite. UHD is subscribed to the services of this system. You can both create and host videos using this system.

YouTube. Any person can create a channel on the site, post video and audio recordings, and add free captions, if needed.

Vimeo. Similar to YouTube, this site can host your videos.

Slideshare. This program makes it possible to upload and share presentations with other people.

Tips for Creating Video Materials
Videos are an effective way to present content to students who are not only used to digital input, but have also come to expect it. While it is relatively easy to upload YouTube videos in Blackboard, these videos may not always meet the Americans with Disabilities Act (ADA) requirements. In order to make sure that the ADA standards are met, create customized videos. Listed below are links to resources on how to create videos using different applications:

- “The Excellent Tools for Creating Videos without Installing Software,” by Richard Byrne
- “How to Create Professional YouTube Videos for FREE,” by Lewis Clifford

Here is a list of available applications for producing video content:
- Animoto
- Vyond
- Masher
Section H: Accommodating Students with Disabilities
To accomplish the goal of providing the best educational experience to all students at UHD, consider accessibility issues and the Americans with Disabilities Act requirements and ensure that students with disabilities get access to all course materials and functions. The Office of Disability Services at UHD can assist in preparing online courses.

Backboard ALLY is a program integrated with Blackboard. It scans available materials and flags any potential issues with uploaded files, including

1. “unreadable” pdfs (those that cannot be read by screen readers),
2. the absence of heading styles in a file, which make documents easier to read, and
3. the absence of alt tags with visuals.

To access your ALLY score, click Course Tools → Accessibility Report. The goal is to be in the green.

Some of the ways to address the flagged problems including the following:

“Unreadable” PDFs and Heading Styles
Some course materials may not be compatible with JAWS, which is a screen reading software used by students with visual impairments. For example, some scanned materials may not be recognized by the program. Consider using simple word processing programs such as Microsoft Word or Notepad for creating pdfs. Use heading styles to mark sections. If you need to use scanned materials, contact the library and the Office of Disability Services and request their help finding sources of readable pdfs. For shorter handouts, use Adobe Professional’s optical character recognition function. Click Tools → Action Wizard → Make Accessible. The program will go through several steps in character recognition and ask for descriptions. The program is not perfect and will leave lots of typos that need to be corrected.

Absence of Alt Tags with Visuals
When a screen reader encounters a visual in a file, it can only read an Alt Tag that has been attached to that visual. To add a description in Microsoft Word 2016, right-click on the visual. Click Format Picture, then Layout & Properties. Click Alt Text. Add a title and a description. Descriptions for different visuals can vary depending on the type of a visual: “active,” “informational,” “textual,” or “decorative” (UC Davis Canvas). See examples to decide how much information to include with each visual type.
Closed Captioning
Although ALLY does not flag videos without closed captions, it is prudent to be prepared to accommodate students who need lecture script. YouTube can do closed captions automatically. The Office of Disability Services has a contract with a service provider that will caption video materials if the materials are submitted to the office in advance (approx. 2 weeks). Alternatively, the script can be submitted as a separate file to the Office of Disability Services if a request for accommodations is received.

Google Slides offers a free synchronous captions while you are presenting your slides. While in a Zoom session, open your slides with Google Slides, share the screen, activate closed captions while in a presentation mode, and record the Zoom session with closed captions. Zoom also offers transcription for files uploaded to the cloud (Contact TTLC for instructions). They are stored in the cloud for about three months.

To get other tips on working with students with disabilities, consult the following resources:

- WebAIM.org
- ADA.gov
- “Online Course Design: 8 Tips for Teaching Students with Disabilities,” by Kristen Przyborski

Section I: UHD CTLE and TTLC Tools and Resources
When developing an online course, remember that UHD’s CTLE and TTLC Support staff members are always willing to help. The table below lists some of the essential links and contact information to get assistance.

<table>
<thead>
<tr>
<th>Support Services</th>
<th>Materials, Resources, and Training</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UHD Center for Teaching and Learning Excellence (CTLE):</strong> (713) 221-8280; (713) 221-2724 <a href="mailto:ctle@uhd.edu">ctle@uhd.edu</a> Location: ACAD 700A</td>
<td>Getting Started with Teaching Online UHD Rubric for Online Instruction UHD Online Teaching Certificate Program Professional Development Grants for Online Education</td>
</tr>
<tr>
<td><strong>UHD Blackboard Support</strong> (713) 221-2786 <a href="mailto:bb@uhd.edu">bb@uhd.edu</a> Location: ACAD 700</td>
<td>Blackboard - Semester Startup Blackboard Add-On Tools (Turnitin, Softchalk, Respondus, and Respondus Monitor) Blackboard Ally Faculty &amp; Staff Training</td>
</tr>
</tbody>
</table>
Section J: Course Demonstrations
In addition to online course demonstrations available on the CHSS Online Teaching Initiative’s page, instructors could review exemplary courses recognized by Blackboard each year.

Tours of Blackboard Exemplary Courses:
- 2014 Blackboard Exemplary Course Tour- EEC3204
- Blackboard Exemplary Course - MEE7633 Video Tour
- ETT 510 - Blackboard Exemplary Course Tour
- 2012 Blackboard Exemplary Course Award
- 2014 Blackboard Exemplary Course Award Winner
Appendix: Works Cited and Supplemental Bibliography

Online Education


Collaboration

Assessment

Organizing Discussions

Providing Feedback

Student-Instructor Interaction


### Addressing Student Needs


### Service Learning Activities


### Evaluating Online Courses


### Preparing Teaching Materials